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Welcome to Sentinel

Sentinel is a print security, cost control and management solution. Document security can be improved in an
organisation by using the pull printing and secure function lock features.

You can monitor and reduce your printing costs by implementing pull printing to reduce waste, assign guotas to
limit what users can print, and assign budgets to departments to give them targets to meet.

Managing printing is easier with Sentinel as it using profiles to manage settings and apply them to groups of users
or printers. Mail2Print brings secure monitored printing to tablets and smartphones whilst ScanDirect enables
secure scanning without the need to deploy scanner drivers.

Using This Document

This implementation guide is intended for the Sentinel administrator or tester. It contains initial instructions on
how to set up the Sentinel system. For more information about the Sentinel interface, read the context-sensitive

online help by clicking the help buttons Y on each Sentinel screen.

Assumptions

This document assumes
e You have read the Sentinel Installation Guide and the Sentinel installation is complete.

e There is at least one printer set up according to Microsoft standards and functioning correctly via the
server.

e You can access the main Sentinel Overview screen on the server.

Sentinel Implementation Guide 1
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Users

Sentinel makes it easy to manage multiple users in your organisation. You can create different profiles and apply
them to groups of users to help cut down administration time. It is also possible to import users from a database

such as Active Directory.
In this section you will define two user profiles, one group, configure the default user and add a new user.

Setting Profiles

User profiles are sets of predefined user definitions.

Step 1: Define First Profile

1. Select Start > All Programs > Sentinel > Sentinel web page.

2. Click Users.
The Users tab is highlighted.

3. Click the Profiles tab.
One default profile is already defined.

4. Click Add New.
The Add New Profile screen opens.

5. Fill'in the following fields:

Field Value Explanation

Profile Name Admin The name of the user profile.

Print Option Use System Takes the Print Option defined for the Default Profile.
Defaults

Allow Web Allow Allows users to release print jobs via the Web interface.

Release

Allow Keypad Allow Allows users to release print jobs by entering their keypad

Release code on the device controller.

Budget (leave blank) When left blank, is unlimited.

Profile (ensure all Allows all kinds of printing.

Permissions selected)

6. We will return to some of the fields later. Click Save.

2 Users
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Step 2: Define Second Profile

1.

2.

Configure another profile, with different values:

Profile Name General
Print Option Last document
Allow Web Release Allow
Allow Keypad Release Allow
Budget 100
Click Save.

Configuring a Group

Step 3: Define a Group

1.

2.

3.

The Users tab (the top level) is highlighted. Click the Groups tab (lower level) and click Add New.
The Add New Group screen opens.

The fields in the table are mandatory and you must fill them in:

Field Value Explanation

Group Name Test The name of the user group.

Group Profile Admin This is one of the profiles you defined above.
Click Save.

Setting up Users

NOTE: You can automatically add multiple users using the Auto Sync feature and Active Directory. This feature is
explained later in this guide. For now, we will configure and add users manually.

Step 4: Configure the First User

1.

The Users tab (the top level) is highlighted. Click the Users tab (lower level). The name of the user who
performed the Sentinel installation is shown. You cannot change this user name.

Click the Edit button E on the right of the user.
The Edit User screen opens. Sentinel has already assigned some values to this user, as shown in the table.

Fill in the fields with the new values as shown in the table.
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Field Default New Explanation

Value Value

User name <user name> Sentinel inserted the Windows login name of the person
who installed Sentinel. Sentinel uses this name to identify
the user in future activities. You cannot change this name.

Card ID 0000 12345678 Change the default value as shown. Mandatory
(alphanumeric). The user's identification code. Sentinel
uses this ID to track the print jobs as they move through
the system. Users identify themselves with this ID when
they pull their print jobs.

Keypad Code 12 Since card IDs can be very long, the keypad code is a
convenient alternative for users who want to enter a code
at the device controller rather than using a card. An alias
for Card ID.

User Type Administrator An administrator can connect to the Sentinel Web
interface from remote machines and see the full
administrator menu whereas non-administrators only see
their own print jobs.

Group Test If you use Sentinel reports to track print activity within
groups, you must assign a group to each user.
Profile Admin Use the profile you defined above.
Mail <email The user’s email address for receiving scanned documents
address> (Scan Direct) and direct printing of email messages and

attached files (Mail2Print).

4. Click Save.

Step 5: Add a Second User

Define another user, with different values.

1. Click Add New.
The Add New User screen opens.

2. Type in the values shown in the table.

Field Value Explanation

User name <user name> Mandatory. Sentinel uses the user's Windows login name
(to Active Directory or to the local workstation) to
identify the user. Make sure you use the correct name of
a person defined in the system who is not an
administrator. The user name is not case sensitive.

Card ID 87654321 Mandatory (alphanumeric). The user's identification
code. Sentinel uses this ID to track the print jobs as they
move through the system. Users identify themselves with
this ID when they pull their print jobs.
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Field Value Explanation

Keypad Code 87 Since card IDs can be very long, the keypad code is a
convenient alternative for users who want to enter a
code at the device controller rather than using a card. An
alias for Card ID.

User Type Standard An administrator can connect to the Sentinel Web
interface from remote machines and see the full
administrator menu whereas non-administrators only see
their own print jobs.

Group Test If you use Sentinel reports to track print activity within
groups, you must assign a group to each user.

Profile General Use the profile you defined above.

Mail <email address> The user’s email address for receiving scanned

documents (Scan Direct) and direct printing of email
messages and attached files (Mail2Print).

3. Click Save.

Step 6: Test the Users

1. From another PC, log in to the Sentinel web interface with the user name that Sentinel created (and you
configured in Step 4: Configure the First User).
You should be able to view and access all the Sentinel data.

2. You are defined as an administrator with IS, so from your computer you cannot see what the standard
user you defined in Step 5: Add a Second User sees. To do so, make a note of the URL from the top of your
browser window, and type it in at another computer. E.g., http://129.169.4.24/Sentinel/.

3. If prompted for a user name and password, type in the Windows name you used for the second user.
Note that you can only see a limited set of information._You might want to save this URL so that users can
save their own accounts, create a temporary ID, etc.

You now have two defined users; the next step is to define a printer.

Sentinel Implementation Guide 5
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Devices

Sentinel makes it easy to manage multiple printers in your organisation. You can create different profiles and
apply them to groups of printers to help cut down administration time.

Let’s set up some printers.

Step 1: Determine Print Modes

Before you can add printers to the Sentinel system, you must decide which mode of printing the system is going to
use. You may deploy a combination of the following modes within your system; they are not mutually exclusive.

Virtual Printing

One or more virtual printers (e.g., B/W, color) are defined on the network. All the users send their print jobs to
one of these printers. The user may then go and "pull" their printout from any printer throughout the organization
(that matches the print type), wherever they personally enter their ID code.

Each workstation that uses this mode must be configured to use the virtual printer. This is done only once, as part
of the system's initial setup. Printer settings are not managed at the level of the workstation.

Advantages:
o All workstations can use the same printer settings, no matter where the users collect their printout.

e The user needs to install only one printer driver per printer type. The type can be color, black and white,
cheques, copy, color copy, or scan.

e If aprinteris out of service, the user can release print jobs on other printers.
¢ Sentinel balances the load on the servers by moving print jobs from one print server to another.

Virtual Pull Printing

With pull printing, print jobs are not released until the user releases the job for printing by standing next to a
printer and self-identifying. The physical printer that prints the job is the user's default printer, defined by the
administrator in the Sentinel management interface.

Advantages of pull printing:
e Print jobs are more secure; no one can read the printout without the user’s permission.
o Paper issaved, as jobs are only printed when the user goes to collect them.

Pull Printing via BSI-Enabled Printer
Steps:
1. The user sends the job.
2. The user goes to the BSl-enabled printer and self-identifies using the built-in Sentinel controller.

3. The job prints.
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Pull Printing via External Device
Steps:
1. The user sends the job.

2. The user goes to any printer throughout the organization and self-identifies using the external Sentinel
controller.

3. The job prints.

Virtual push printing

Push printing means that when the user sends a job to print, it prints immediately (assuming the printer is
working).

Advantages of push printing:

¢ The user has only one printer driver for each type of printer. The type can be color, black and white,
cheques, copy, color copy, or scan.

e Ifaprinteris out of service, the job can be printed at a similar type of printer.
e Jobs are printed as soon as the user sends them to print.

Non-virtual push printing
The user must install a printer driver for each printer. The user has permissions for automatic release or manual
release using the web-based Sentinel management interface.
Advantages:
e Large print jobs can be printed without the user having to wait next to the printer.
o Special users such as managers prefer this option as they want to print without waiting.
Steps:
1. The user sends the job to the usual printer.

2. The job prints out immediately. The user collects the printed pages.

Step 2: Configure a Printer

You can define a profile and a group for printers. These are more advanced options and it is worthwhile exploring
the available options at a later stage. We do not address device profiles and groups here. If a profile and group are
not defined, Sentinel uses default options for these parameters.

In this section, you will define two printers — one for virtual pull printing and the other for non-virtual push
printing.

BSI-enabled Device

If you have a BSI-enabled device:
1. Verify the printer device is attached to the network and that you have installed a driver.
2. Select Start >  All Programs - Sentinel -  BSI Configuration Utility.
3. Insert the BSl-enabled printer's IP address.

Sentinel Implementation Guide 7
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4,
5.
6.
7.
8.

Select a printer from the list. Make a careful note of this printer name as you will need it for Mail2Print.
The printer server's IP address should appear automatically. You can change the default IP.

Select Enable for Sentinel. This action adds the device to the Sentinel devices list.

Click OK and Close to close the BSI Configuration Utility.

Go to Step 3: Test the Printer.

External Sentinel Controller

This section only applies if you have an external Sentinel Touch Screen Controller.

Run the external device manager and then configure the device:

1.
2.

Verify the printer device is attached to the network and that the driver is installed.
Select Start >  All Programs >  Sentinel >  External Device Manager.
The External Device Manager launches and looks for new devices.
From the device list, double-click the device you want to configure. The device’s Settings window appears.
Set up the specific definitions to match your network environment and your Sentinel system. These
settings include Device IP Address, Gateway IP Address, Subnet Mask, and Destination IP Address (print
server's address).
Select Start >  All Programs >  Sentinel >  Sentinel web page.
On the Sentinel web page, click the Devices tab.
If the device is in the list of all currently configured devices, select the device that you just added and click
Edit. The Edit Printer screen opens.
If the device is not listed, add it by clicking Add New. The Add Printer screen opens.
Fill in the parameters as shown in the table.
Field Value Explanation
Device External Assumes pull printing.
Type
Printer <B&W/Color/ Select the type of the printer relevant for your device.
Type Cheques/Copy/Colo
r Copy/
Scanner/
undefined>
IP Address — <XXX.XXX.XXX.XXX>  The fixed IP address of the new device.
External <YYY.YYY.YYY.YYY>  For a Sentinel external controller combined with a BSI-enabled
Controller device: the IP address of the controller.
Printer <printer name> Select the printer from the list of printers attached to the device.

Devices
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Field Value Explanation

Print or Multifunction Specify the device type relevant for your device:

Copy (assuming the e Printer — The waiting print job is released according to the
device allows defined print and user options. This device type does not
printing, copying, allow scanning or copying.
and scanning) e Copier — Sentinel opens the copier machine for a predefined

period of time (see the Time-Out Copy field) in which the user
can make copies. When the time period ends, or after the
user presses the <ESC> button on the device, the machine is
locked again and the number of copies printed is written to
the server’s database. This device type does not allow
scanning or printing.

e Multifunction — The controller on the device asks which
function to perform (usually "Print" or "Copy"). This is the
only device type that allows scanning.

Scan Direct  Select Allows you to scan documents to a particular folder or email address.
See Scan Direct. The print type must be multifunction.

9. Click Save.

Step 3: Test the Printer

1. Send a print job to the printer you set up in Step 2: Configure a Printer.
You configured the printer driver for pull printing so the print job does not print because it is held in the
Sentinel print queue.

2. Onthe Sentinel web page, click the History tab to see print jobs that are waiting to be printed.
You should see the print job you submitted earlier.

3. Go to the Brother BSI-enabled printer and follow the on-screen instructions on the control panel of the
printer. When prompted for an ID number, use your keypad code (12) to release the print job.

4. Return to the Sentinel screen.
The History tab now shows that the job you just printed is no longer on the server.

Step 4: Configure a Push Printing Device

In this step you will set up a printer for non-virtual push printing.

1. Set up the parameters as shown.

Field Value Explanation

IP Address  0.0.0.0 The fixed IP address of the new device.

Device Push Printing The system does not hold the jobs, just monitors them, and jobs are
Type printed as soon as they are sent

Printer <printer name> Select the printer from the list of printers attached to the device.

Sentinel Implementation Guide 9
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Field Value Explanation
Printer <B&WY/Color/ Select the type of the printer relevant for your device.
Type Cheques/Copy/Colo

r Copy/

Scanner/

undefined>

Step 5: Test Push Print

1. Send a print job to the printer you set up in Step 4: Configure a Push Printing Device.
You configured the printer driver for push printing, so Sentinel prints the job immediately.

2. Go to the printer and collect your printout.

You have now tested two different types of printing (virtual pull and non-virtual push). The next step is to scan and
send printed documents directly to email using Scan Direct.

10 Devices
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Scan Direct

The Scan Direct feature allows your users to scan printed documents and have them sent directly to the users’
email addresses. You define these parameters once for the whole Sentinel system; not just for a specific user.

Step 1: Define Scan Direct Settings

1. On the Sentinel web page, if you have not already done so, click the Settings icon ' (on the top right of
the screen).

2. Click the Scan Direct tab.
3. Type in the following values. These fields are all mandatory.

Field Value Explanation
Sender Email <email Email sender’s address as you want it to appear in the received
address> email message delivering the scanned document. Must be a valid
and existing email address.

SMTP Server <SMTP ID> SMTP server's IP address or name.

Port <port Outgoing email SMTP port. Default: 25.
number>

Incoming folder (Keep the The main folder on the Sentinel server where the metadata
default) (information about print jobs) and scanned documents are stored

temporarily. Subfolders are created, automatically named with the
scanner's device name.

Authentication The Sentinel printer needs this information for the network scan
Settings profile.
Sentinel Server IP Scanned docs go to this server.
User name Sentinel treats the printer as if it is a user, identified by this (new)
user name.
Password The password for the user name.
4. Click Save.

Step 2: Test Scan Direct

1. Atany pull printing printer, identify yourself using the keypad code 87 you defined for the second user.
(Note that your user configuration included enabling Scan Direct.)

2. Scaninadocument by pressing the Scan button on the control panel.

3. Check that you received the document in an email, sent to the email address you defined when setting up
the user.

Sentinel Implementation Guide 11
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Quotas and Budgets

You will now determine how much it costs to print different page types (B/W, color, etc.) for a specific type of
printer.

Later, you will configure the quota and budgetary limits for different user groups. The quota is the frequency with
which you reset or add to the defined budget for a user group. The quota policy enables Sentinel to update the
budget figure automatically, at predefined intervals.

Printer Pricing

In this section you define prices per page for each of the page types. While each printer type has a base price for
printing a standard page, you can add or subtract a fixed amount from the base price to get a more accurate
accounting of printing costs. These prices are used in Sentinel reports and to determine budget utilization.

Let’s add prices.

Step 1: Check the Base Price

1. Click the Accounting tab and the Printer Pricing tab.

1. Click the Edit button IZ on the right of the Color (or Mono, if that is what you have) printer type.
2. Set the Base Price for printing on this type of printer to 1.17.
3. Click Save.

The base price for that printer type is displayed.
Step 2: Set Page Type Prices

1. Click the plus sign ¥l on the left of the Color printer type.

2. Type the values as shown in the table.

Field Value Explanation
A4Price The prices you add here are increments to the base price.
A3Price 3 So A4DupPrice printing will cost (1.17 +.9) 2.07 EUR total
A4DupPrice .9 per page.
A3DupPrice 1.7

3. Click Save.

Step 3: View Actual Printing Costs

In this step, you will send a few jobs to pull printing, and run a standard report that shows how much it costs to
print them.

12 Quotas and Budgets
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1. Inany software application, print a page or two to the pull printer you defined in Step 2: Configure a
Printer. Repeat.

2. Go to any Sentinel printer and release your print jobs.

3. Inthe Sentinel web page, click the Accounting tab.
The Report Type screen opens.

4. Click User Summary.
5. InFilter Results By, select User and type in your user name (as recognized by Sentinel).

6. Click Execute.
The Report Viewer opens.

7. Examine the report to see how many pages in total were printed and how much they cost. Click Close.

Quota for a User

In this section you define a quota policy and assign it to a particular user.
In the following sections, you will define a new policy and assign it to a user profile and see the budget utilization
per group.

Step 1: Define a Quota

1. Inthe Sentinel web page, click the Accounting tab and the Quotas tab.

2. Click Add New.
The Add New Quota Policy screen opens.

3. Type in the following values.

Field Value Explanation
Policy Name Quotafor  The name of the policy.
Admin
Update quota policy onday [X] 1 The day ([X]) of the month and the frequency (every [Y]
of the month, and perform 2 months) that the policy rules are performed.
update every [Y] months
Quota Budget 50 The budget figure for this policy. The figure applies to the

[Y] months you set in the previous field. If blank, the
budget is unlimited and quota policy has no effect. Default:
blank.

Increment/Reset to Increment  The method of fixing the budget (select one). If increment,
any remaining budget will be added to the additional
budget allocated every [Y] months. If reset, any remaining
budget is removed.

4. Click Save.
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Step 2: Assign the Quota Policy to User
1. Click the Users tab.

2. Click the Edit button B on the right of the user you configured in Step 4: Configure the First User.

3. Inthe Quota Policy field, select Quota for Admin.
4. Inthe Budget field, type 100.

Quota for a Profile

In the previous section you defined a policy and assign it to a particular user.
In this section, you will define a new policy and assign it to a user profile.

Step 1: Define a New Quota

1. Click the Accounting tab and the Quotas tab.

2. Click Add New.
The Add New Quota Policy screen opens.

3. Type in the following values.

Field Value

Policy Name Quota for General Profile
Update quota policy on day [X] of the 1
month, and perform update every [Y] 1

months

Quota Budget 30

Increment/Reset to Increment
4. Click Save.

Step 2: Assign the Quota Policy to a Profile
1. Click the Users tab and the Profiles tab.
2. Click the Edit button B on the right of the General profile.

In the Quota Policy field, select Quota for General Profile.

4. Inthe Budget field, type 50.

Now, all users (in this case, the second user you defined) assigned to this profile inherit this quota and budget. You
can still change the quota and budget for a specific user as we saw in the previous section.
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Step 3: See the Effect of Printing on the Budget

Print a couple of pages to see that the user credit is reduced.

Budget Utilization

You have already determined the pricing policy and set yearly budgets for a user profile and a specific user, and
limited that budget by defining quotas. Once the users start printing their jobs, you will be able to see how much
of those budgets have been utilized.

1. Click the Accounting tab and the Budgets tab.

The screen shows how much of the budget for the different user groups has been utilized so far this year,
broken down by month.

The percentage figure on the right indicates how much of the yearly budget has been used.

2. (Optional) You can change the yearly budget by clicking the Edit button B on the far right and typing a
new figure.

3. Print some pages.
4. To verify that the budgets are being used, go to the Accounting tab and the Budgets tab.

When a user exceeds the defined budget, Sentinel prevents the jobs from being printed. Instead, the user sees an
error message on the printer console and Sentinel posts a notification to the log.
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Reports

Once the system has been running for a while, you can generate reports to understand and improve your
organization’s printing resources. For example, in the Quotas and Budgets section you generated a standard
report. In addition, you can customize and schedule your own reports.

Running Standard Reports

There are several types of reports that can be generated. Each report can be filtered according to dates, job
status, and additional data fields such as printer, user, and bill code.

1. Click the Accounting tab.
2. Select a report type and the filters as described in the table.

Parameter Explanation
Filter Date A range of dates for the report:

e All-Allinformation from the database with no date limitations.

e last— Data from the last day, week, month, or year.

o From/To - A date range for the data (either from a starting point or to
an ending point). Click the calendar icons to select dates.

Filter Status Generates data for specific statuses. See History for an explanation of all
statuses.
For example, a useful report shows only Deleted and Cleared jobs. This allows
you to see how many pages are sent to the printer but not picked up or deleted
before they are released.

Filter Results By Filters the desired report only to a specific parameter (or combination of
parameters):

e Printer — Generates data for a specific printer. To specify more than one
printer, use a semicolon (;) between printer names, with no spaces
before or after.

e User — Generates data for a specific user. To specify more than one user,
use a semicolon (;) between user names, with no spaces before or after.

¢ Bill Code — Generates data for a specific bill code. To specify more than
one bill code, use a semicolon (;) between bill codes, with no spaces
before or after.

e Group — Generates data for a specific user group. To specify more than
one group, use a semicolon (;) between group names, with no spaces
before or after.

Page Types Generates data only for specific printer types.
Enabled only if you select one of these reports:
e User Summary
Bill code by User
Bill code by User Table
Group Summary
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3. Click Execute.
Sentinel generates the selected report in the Report Viewer.

4. Click Close (on the top right of the screen) to return to Sentinel.

Printer Reports (Summary and Detailed)

The summary report shows you the total number of pages printed on a specific printer.
The detailed report gives you more detailed information about each of the print jobs printed on each printer.

User Reports (Summary and Detailed)

The summary shows you the total number of pages a specific user printed.
The detailed report gives you more detailed information about each of the print jobs printed by each user.

Bill Code Reports (Summary and Detailed)

The summary report shows the total amount of pages printed for a specific bill code.
The detailed report gives detailed information about each of the print jobs printed for each bill code.

Bill Code Reports (By User and By User Table)

These reports show you the total number of pages a specific user printed for a specific bill code, but in two
different types of presentation.

Group Summary Reports

The distribution of usage per group.

Number of Jobs by Page Count Reports

The number of pages on average that are printed for each print job.

Top 50 Jobs by Page Count Reports
The fifty print jobs with the largest number of pages.

Designing Custom Reports

In this section you will design your own report using software called Sentinel Report Designer.

Step 1: Download the Report Designer

The first time you use custom reports, you must install the software:
1. Inthe Sentinel web page, click the Accounting tab, the Reports tab, and the Custom Report tab.

2. Click Download Designer and follow the prompts.
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Step 2: Design a report

To create a custom-designed report stating how many color pages were printed over the last month:

1. Select Start > AllPrograms = FastReports = FastReport Designer.
The FastReport designer opens. (You only need to do this step when creating a new report.)

2. Write a title for the report:

a. Click the Texticon “*| on the far left and click the white area next to Report Title.
b. Double click, type My First Report, and click OK.

c. Enlarge the display area for the report title by dragging the outline. Enlarge the text via the Font
Size icon.

3. Connect to a database table:

a. Click the white area next to Data. Open the Data tab 2l on the far right of the screen. Under
Actions select New Data Source.

b. If you are using an Access database, click New Connection.

c. Enable Always use this connection. In Database file, if necessary, type the server name (e.g.,
\\199.166.4.28\c$), navigate to \inetpub\wwwroot\Sentinel\App_Data (or equivalent), and
select the MDB file.

d. If necessary, type a user name and password. Click Test connection. When you get a success
message, click OK twice.

e. Click Next. From the list of tables in the database, select Archive and click Finish.
4. Add a calculation to determine how many pages were printed for each job:

a. Onthe right, click the Data tab, open Data Sources and Connection. Right click Archive and select
New Calculated Column.

b. Anew field called Column is created. Select it and click the Properties tab on the far right of the
screen. Change (Name) to TotalPages.

o

In Expression, click the icon on the right to open the Edit Expression dialog.

o

Open Archive and double click Pages.
In the edit box, type an asterisk (“*”).

f.  Under Archive, double click Copies. (It should now contain this string:
[Archive.Pages]*[Archive.Copies]). Click OK.

5. Add fields to the report:
a. Double click Data on the left of the screen. In Data Source, select Archive. Click OK.

b. Drag JobName to the white area on the right of Data: Archive.
JobName also appears in the Page Header.

c. Drag User, Released, and TotalPages to the right of JobName in the white area.
6. Limit the view to color pages printed during the last month:

a. Double click Data: Archive on the left and select the Filter tab.
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7.
8.

b. InFilter expression, type this string: [Archive.PageType]==3 &&
[Archive.Released]>AddMonths([Date],-1). Click OK.

1
c. Preview the report by clicking the Preview icon i==:. Click Close.

Save the design by clicking File >  Save As and calling your report MySavedReport.

Close FastReport (you must close it completely and not simply minimize it).

Step 3: Run the Report

Make the design available on the server by registering the report, and run it:

1.
2.
3.

In Sentinel, click Register Report.
Type Color Pages Report for the report name.

Navigate to the saved report and click Open and Register.
The report name appears in the list on the left of the Sentinel screen.

Run the report by highlighting it in the list and clicking Run.
The generated report appears in the Report Viewer on the right of the screen.

Manipulate the view of the report using the icons on the top right of the screen (e.g., Next Page).

Step 4: Edit the Design

Edit the report design and then run it:

1.

Highlight ColorPagesReport in the list on the left and click Re-Design. In the dialog, click OK and save the
report.
FastReport opens automatically.

Add a name for the value:

a. Click the Texticon “* on the far left and move the mouse to the white area to the right of Data.
b. Double click, type Total Color Pages, and click OK.

Add a total for all color pages printed:
a. Onthe right, click the Data tab, highlight Totals, right click, and select New Total.
b. Change the value in Total name to Total Color Pages Printed.
c. In Data column or expression, open Connection and Archive, and select TotalPages. Click OK.
d. Drag the Total Color Pages Printed field into the white area on the right of Page Footer.

Click File > Save. Close FastReport.

In Sentinel, delete the ColorPagesReport report by highlighting it and clicking Delete.

Register the report on the server by clicking Register Report, typing ColorPagesReport for the report
name, navigating to the saved design, and clicking Register.

Run the report by clicking Run.

Sentinel Implementation Guide
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Scheduling Custom Reports

In this section you will schedule the ColorPagesReport report to run at a particular time.

To add a new scheduled report:
1. Inthe Sentinel web page, click the Accounting tab, the Reports tab, and the Schedule Report tab.
2. Click Add New.

3. Select a monthly report by clicking Add Monthly Schedule.

Field Value Explanation

Schedule Name Monthly Color Report

Report Name ColorPagesReport

Start Date <tomorrow’s date>

Recur every [X] 1

months

To File <path>SentinelMonth  Allows saving the report as one or more files: Add a file

lyReport location by typing an existing path and a file name (without

an extension, which Sentinel adds automatically) and clicking
Add Path.

Export Format PDF

4. Click Save.
5. Run the report right now by selecting Monthly Color Report and clicking Run Now.
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Monitoring and Administration

Several screens in Sentinel allow you to monitor print activities. You can see jobs that have been spooled but not
printed, events that occurred in the system over a specified period of time, and errors and warnings.

Waiting Jobs

Click the History tab and the Waiting Jobs tab.

This screen lists print jobs that were sent to Sentinel, but have not yet been released.

Only administrators can see everyone’s print jobs. Non-administrators can only see their own jobs.
You can use the search options to narrow the display to only print jobs answering specific criteria.

Each print job shows the job ID number, the print job name, the name of the user who sent it, the printer it was
sent to, the type of printing (B/W, color, etc.), the current job status, the number of pages and copies, and the
time it was spooled.

The available job statuses (shown in the Status column) are explained in the table.

Wait The print job is waiting for a user to release it.

Held The print job is held in the queue and will not be released, even when the Delete
unprinted jobs after time period expires (defined for the user).

Resume The job was held temporarily and is now waiting for the user to release it.

You can control the displayed print jobs. Select one or more jobs and click the relevant button.

Parameter Explanation

Release Now Releases selected print jobs to the printer immediately. Useful if there is a very
large print job that was sent and the user doesn’t want to wait by the printer.
This option is not available if Allow Web Release is not selected in your user

definitions.
Resume Stops the hold.
Hold Holds the print job and does not release it.
Delete Deletes the print job.
Change selected jobs Changes the destination printer to a different printer than the one to which the
printer to: print job was sent. Select a printer and click Change. Since this action is

performed automatically when identifying with an ID card at a different device
than the one to which the print job was sent, this option is only useful when
planning to release a print job with Release Now to a different printer.
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History

Click the History tab (on the top menu level) and the History tab (on the lower menu level).

This screen displays all the events that occurred in the system within the defined period of time (defined in
Settings).

The information displayed here depends on the level of permission you have. Administrators can see everyone’s
print jobs. Non-administrators can only see their own jobs.

You can use the search options to narrow the display to print jobs answering specific criteria.

Each print job shows the job ID number, the print job name, the user who sent it, the printer it was sent to, the
type of job itis (B/W, color, etc.), the current job status, the number of pages and copies, and the time it was
spooled.

The available job statuses are explained in the table.

Status Explanation

Printed C The job was released by a user using an ID card at a device.

Printed K The job was released by a user typing a keypad code at a device.

Printed W The job was released by selecting the job and releasing it from the Web
interface.

Printed A The job was released automatically either because the job was sent to a virtual
device (IP = 0.0.0.0) or the user sent this print job defined as Auto Print for the
user.

Printed P The job was released after the user confirmed the printing via a popup window
at the user station, or the user supplied a bill code.

Printed T The job was released by a user using a temporary ID card at a device.

Copied The job from a copier or a multifunction device was released.

Scanned The job from a scanning station was released.

Deleted The job was sent and manually deleted from the jobs menu.

Cleared The job was sent and was not released when the Delete unprinted jobs after

time period expired (defined for the user), and therefore was automatically
cleared from the system.

System Events

Click the History tab and the System Events tab.
This screen displays the all events, errors, and warnings that occur in the system.
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Synchronization with Active Directory

The Sentinel system offers several ways to connect and synchronize user details.
The Auto Sync settings control options related to synchronizing the User Table (Sentinel’s own internal database
of users) with external resources, such as the Active Directory (AD) or external SQL databases. Rather than having
to manually enter information for each user, you can easily synchronize with existing information. This is useful
when organizations maintain detailed user information in their Windows AD.

1. In the Sentinel web page, click the Settings icon " (on the top right of the screen).

2. Click the Databases tab.
The Auto Sync screen opens.

3. Select Enable Auto Sync.

NOTES:
o Allfield values are case sensitive.
e You cannot make changes to the values on this screen if Enable Auto Sync is not selected.

LDAP Synchronization

4. Select Use LDAP to get users from active directory.

5. Define values as shown in the table.

Parameter Value Explanation
Domain Name <domain> The domain name that has permission to access the AD.
Card ID field name  <field> You can use any LDAP field; for example, if your organization

doesn’t use pagers, the Pager field (from AD) can be used as
a Card ID field. If this were the case, you would type Pager
here.
If Use LADP Server to get users from active directory is
selected, this field is the minimal required setting.

AD user <user name>  The user name with permission to access the AD.

AD Password <password> The password associated with this user name.

You can match field names existing in your AD database with field names defined in Sentinel:
1. InFrom LDAP field, type the AD field name, e.g., extensionattributel.

2. InToField, type the corresponding Sentinel field name, e.g., KeypadCode.

3. Click Add.
The new correlation is shown.

4. Add as many field name pairs as you like, clicking Add after each pair.
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5. Click Save.

Users are added into the system once they print. Users do not appear automatically unless they send a

print job.

AD and SQL Synchronization

You may need to get data from more than one AD database:
Select AD and SQL Sync.

Type the Card ID field name under Use LDAP.
Type the User field name under Use SQL Server.
Type the Card ID field name under Use SQL Server.

Click Save. Synchronization begins.

© g~ w Dbh e

Reminder: When you finish configuring, select Enable Auto Sync.

24

Synchronization with Active Directory



SENTIN=L

Your pull printing solution

Mail2Print

Use Mail2Print to print email messages and attached files (documents and images). You can print by sending an
email message, without connecting to your organization's intranet. You can also choose to allow guest printing for
users who do not have direct access to the network. In addition, Mail2Print allows you to track printing jobs from
mobile devices, tablets, and any device with access to e-mail.

Mail2Print is capable of processing and printing up to 2000 pages per hour, depending on the configuration of
server hardware, available resources, and printed file types.

In this section you will set up Mail2Print for a user you defined earlier.

Later, you will set up Mail2Print for a guest user.

Mail2Print for a Recognized User

Let’s set up Mail2Print for the second user you defined earlier.

If you want to manage the server load distribution, you can install Mail2Print on another server (not necessarily
the Sentinel server).

Step 1: Install Mail2Print

1. Start the Sentinel setup and select Install Mail2Print.
The Mail2Print wizard starts. Follow the prompts.

2. You will use the free version of Foxit Reader, so do not register it.

3. When prompted for the Database Server Connection String, insert the details (IP address or server name,
database name, user ID, password) for the Sentinel database server as shown.
Sentinel creates a printer driver for you called Mail2PrintPrinter.
WARNING: Do not change any of the printer settings; in particular, the sharing settings.

Click Test Connection.
Select a printer driver from the list.

Click Done and restart the computer when prompted.

A

Verify that the Mail2Print service is active: Select Start > Run >  services.msc.
You should see Mail2Print in the list of services, with Status: Started.

Step 2: Define Mail2Print Settings

1. In the Sentinel web page, click the Settings icon - (on the top right of the screen).
2. Click the Mail2Print tab.

3. Type the following values.
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Field Value Explanation
Shared Queue <printer The Microsoft Windows share name of the printer that will
name> be used to print Mail2Print jobs (case sensitive).

NOTE: Do not select Mail2PrintPrinter.

You can find the name in the printer properties (Start

- Devices and Printers, select the printer, right click
Printer properties, click the Sharing tab, Share name). It can
be a physical or virtual printer and you must have configured
it in the printers list before defining it as a Mail2Print shared

queue.
Server IP Address XXX XXX.XXX.  The Sentinel print server's IP address. This might not be the
XXX> same server where Sentinel is installed if you are concerned

about server load distribution.

Email Account E.g., Name of the email account that receives the Mail2Print
print@gmail.c messages for processing. Must be a valid, existing address
om and should be dedicated to this purpose. (Users send the

emails from their own email accounts, defined in the user

settings.)

Incoming Server <YYY.YYY.YYY. IP address or name of the incoming mail server. E.g.,
YYY> imap.gmail.com.
Incoming Port <port> Port used at the incoming mail server. Default: 993. (993 is
the port used by Gmail.)
Account Type <type> IMAP or POP3.
This server requires an Depends on the encryption of the incoming mail server
encrypted connection settings.
(SSL)
Outgoing Server <777.777.777.Z7 P address or name of the outgoing mail server.
77>
Outgoing Port <port> Port used by the outgoing mail server.
User E.g., User name (often an email address) used by Sentinel to log
mail@gmail.c  into the incoming mail server.
om
Password <password> Password used by Sentinel to log into the incoming mail
server.

Activate domain Deselect Allows Sentinel to only process email messages that are sent
accounts only from email addresses from the organization's domain name.
Default: selected.

Notify me when ready  Select Allows sending response messages to the user indicating the
status of the job.
<Enable printing Select Print The file types that are allowed to be printed (when attached

attached files of these ~ PDF files to an email). To print the message body, you must select

types>

Print TXT files.

4. Click Save.
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Step 3: Test Mail2Print

1.

2
3.
4

Locate a PDF file.

Open your email account using the email address defined for the second user.

Create a new message and attach the PDF file. Type a subject.

Send the email to the incoming email address defined in the table above, e.g., print@gmail.com.
Mail2Print opens the attachment and prepares it for printing. Within a minute or two, Mail2Print sends
you an email message indicating success or failure of printing.

Go to any pull printing printer and collect your printout.

Mail2Print for a Guest

Now, let’s set up Mail2Print for a guest user.

Step 1: Define Mail2Print Settings

1.
2.

In the Sentinel web page, click the Settings icon ' (on the top right of the screen).

Click the Mail2Print tab.
You will see the configuration you defined earlier.
In addition, define in the following values.
Field Value Explanation
Guest Budget 100 The print cost limit per guest. If Sentinel cannot recognize

the email of the sender, Sentinel treats the sender as a
guest, so it is wise to set a budget limit for guests. (Each
guest has their own budget.)

Key Size 5 The number of numeric characters that the unregistered
users (e.g., guests) should use in the subject field of the
email message as an identification code. The subject field
must not contain anything else. Default: 5.

Allow Mail2Print Temp  Select Allow guests to use Mail2Print.
User

4,

Click Save.

Step 2: Test Mail2Print

1.

2
3.
4

Locate a PDF file.
Open email using an email address that is not recognized by Sentinel.
Create a new message and attach the PDF file.

Type 55555 as the subject of the email.
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5. Send the email to the incoming email address defined earlier, e.g., print@gmail.com.
Mail2Print opens the attachment and prepares it for printing. Within a minute or two, Mail2Print sends an
email message to the guest email address, indicating success or failure of printing.

6. Go to any pull printing printer. On the control panel, type 55555 as the keypad code. Collect the printout.

Now you have used Sentinel to perform the major functions. Continue working with Sentinel, and read the online

help where necessary by clicking the Help button o .
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Troubleshooting

This section covers errors or problems that can arise when operating Sentinel. If the suggested solution does not
solve the problem, or if you experience a problem not listed here, contact your Sentinel technical support
provider.

For problems relating to installing Sentinel or starting the Sentinel web page, refer to the Troubleshooting section
in the Sentinel Installation Guide.

For explanations related to daily Sentinel operation, refer to the on-line help in the software by pressing the Help

icon @ .

Wrong username appears in the web interface

Symptoms When running the Sentinel web page, the same user name always appears (usually starting
with the prefix "IUSR_").

Cause This error occurs when 1IS uses Anonymous access instead of Integrated Windows
authentication.
Resolution 1. GotollS Settings (Start >  Settings > Control Panel >  Administrative Tools

- Internet Information Services).

2. Expand Local Computer\Web Sites\Default Web Site. Right click Sentinel and select
Properties.

3. Inthe Directory Security tab, click Edit.
The Authentication Methods dialog box opens.

4. Ensure that Anonymous access is not selected and Integrated Windows
Authentication is selected, and click OK twice.

Error message on device: “Aborting 0201/0400” or “Connection Error 03”
Symptoms On a BSI-enabled printer, the user tries to enter the ID and gets the error: “Connection failed
to server. Check network settings.”

Cause The Sentinel server is not active or the device is configured with the wrong IP address.
Resolution Check network settings and that the Sentinel service is active.

Could not use "; file already in use
Symptoms When trying to start the Sentinel web page, you get the error: “The database is currently
locked by the Sentinel service because the right permissions haven’t been set for it.”

Cause Verify this by stopping Sentinel:
1. Go to Windows Services (Start - Settings = Control Panel = Administrative Tools
-> Services).

2. Stop the Sentinel service by right clicking Sentinel and selecting the Stop option.
3. Refresh the Sentinel web page. It should load without the problem.

Resolution 1 1. Make sure the service is running. If you stopped it, start it again (in Windows
Services, select Sentinel and click Start)
2. Open File Explorer and navigate to C:\Inetpub\wwwroot\Sentinel\App_Data\.
3. Right click Sentinel.mdb and click Properties.

4. Click the Security tab. If you don’t see a Security tab, close the Properties window,
and from the Tools menu, select Folder Options. Click OK, confirm, and go back to
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6.
7.

8.

the folder. Right click Sentinel.mdb and select Properties. This time, you should see
a Security tab.

Select the Security tab and click Add.

In the textbox, type Everyone and click OK.

Click Everyone and select the checkbox Full Control under Allow. It automatically
marks all other checkboxes under Allow. Click OK.

Repeat these actions with Sentinel.ldb.

Resolution 2 If the previous steps did not resolve the problem, do this:

1.
2.
3.

Open 1IS Manager and expand the master server node (the Servername node).
Under Web Sites - Default Web Site, right click Sentinel and select Permissions.
Click Everyone and select the checkbox Full Control under Allow.

Service unavailable error
Symptoms When trying to start the Sentinel web page, you get the error: "Service Unavailable”.

Cause This may occur if the server running Microsoft Internet Information Services (1IS) 6.0 is also a
domain controller. The problem occurs because the Application pool is using the NT
Authority\Network Service account, and the account does not have permission to access
the required folders.

Resolution Manually set permissions on the folders for the 11IS_WPG group, and then set permissions on
the folders for the NT Authority\Network Service account.
To set permissions on the folders for the 1IS_WPG group and the NT Authority\Network
Service account:

1.

2.
3.
4

10.

11.
12.

Start Windows Explorer, and then open the folder %systemroot%\Help\iisHelp.

In the right pane, right click the Common folder, and click Sharing and Security.
Click the Security tab, click Add, type IIS_WPG, and click OK.

With [IS_WPG selected, select the following checkboxes under the Allow column,
and click OK:

e Read and Execute

e List Folder Contents

e Read

Repeat the previous step with NETWORK SERVICE instead of IS WPG.

Open the folder %systemroot%\system32\inetsrv. In the right pane, right click the
ASP Compiled Templates folder, and click Sharing and Security.

Click the Security tab, click the IIS_WPG group, and select the Full Control checkbox
under the Allow column. Click OK.

Repeat the above step with NETWORK SERVICE instead of IS WPG.

Open the folder %systemroot%. In the right pane, right click the IIS Temporary
Compressed folder, and click Sharing and Security.

Click the Security tab, click the IIS_WPG group, and select the Full Control checkbox
under the Allow column. Click OK.

Repeat the previous step with NETWORK SERVICE instead of 1IS_WPG.

Restart the 1IS Admin service from the Services snap-in or from the Computer
Management snap-in.

Sentinel menu options not showing (Internet Explorer)

Symptoms Some versions of Internet Explorer (IE) consistently do not display Sentinel menu options or
the Report Viewer correctly.

Cause Browser incompatibility.
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Resolution

=

Change the IE option for Compatibility View by clicking the icon = on the IE toolbar.

Job ID number is inconsistent or not advancing

Symptoms Job IDs appear incorrect or the same for several jobs.

Cause Sentinel saves the last job number as a key in the registry. This key must have write access
permission for all the users using the system. If not defined for all users (usually full control
for everyone for this specific registry key), then Sentinel cannot advance the last job ID and
the job numbers remain the same.

Another possibility is that Sentinel can’t access the registry key at all. In this case, Sentinel
assigns a random number as a job ID, but if there are many jobs, the numbers can
sometimes collide.

Resolution Add write permission to the Sentinel registry key.

Error in file CAWINDOWS\TEMP when trying to make reports

Symptoms

When trying to make any (standard) report from the Sentinel system, you get the error:
“Error in File C:\WINDOWS\TEMP\SumPrinter{<ID>}.rpt: Access to file denied. Another
program may be using it”.

Cause

Sentinel is using Crystal Reports to create its reports, and it requires access to the Windows
temp folder to make temporary calculations before generating the reports. This error
occurs when Crystal Reports does not have access to the Windows temporary folder (usually
c:\windows\temp).

Resolution

Add write permission to the Windows Temp folder.

New print jobs don't appear in the Waiting Jobs list

Symptoms

When printing from the server where Sentinel is installed, the new print jobs appears in the
Sentinel web page, but when printing from other workstations using other user logins, the
jobs do not appear in the Waiting Jobs screen.

Cause

When printing from other workstations to Sentinel, two actions are performed:
e Fand H files are created in the folder ¢:\Sentinel\queue.
e A process (Submitter.exe) is run on these files. The process inserts the information
about these files into the database.
There are two variations for this error: either the files don’t appear in the queue folder at
all, or the files appear in the queue folder but the information is not recorded in the
database.

Resolution

e [f the files don’t appear in the queue folder, add permissions for this folder to
Everyone and give Full Control to the folder (usually c:\Sentinel\queue).

o [f the files appear in the queue folder but are not recorded in the database,
manually record them into the database using the command:
c:\Sentinel\submitter.exe c:\Sentinel\queue\Hxxx
(where xxx is the file number). If the file is recorded now, then it means that the
print process which runs under the user’s login name does not have permission to
run the submitter process. Give permissions for Everyone as Full Control in the
folder c:\Sentinel.

e If you cannot manually submit the file (i.e., running the DOS command as described
above) fails, check that the connection string to the database is correct in the
registry (key: HKEY_LOCAL MACHINE\SOFTWARE\Wow6432Node\Sentinel\
secure\DbConnectionString).
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Unnecessary values in Temp Card ID and Keypad Code

Symptoms You want to delete old values of the fields Temp Card ID and Keypad Code from the user
table.

Cause Typical Sentinel system use.

Resolution Run from the folder where Sentinel is installed (default: c:\Sentinel). Syntax:

e DelKeypad.exe —dt — Deletes the Temp Card ID values for all users.

o DelKeypad.exe —dk — Deletes the Keypad Code values for all users.
For example, putting DelKeypad.exe —dt in a scheduler that runs each night deletes all
temporary cards assigned during the day.

User names not synchronized with Active Directory

Symptoms You want to delete users existing in the Sentinel database but not existing in the Active
Directory/SQL server from where the automatic synchronization is performed.

Cause Typical Sentinel system use.

Resolution Run ADUserSync.exe or SQLUserSync.exe from the folder where Sentinel is installed

(default: c:\Sentinel). Use the utility appropriate for the defined synchronization type.

If you want some users not to be deleted from the Sentinel database even though they
don’t exist in the Active Directory/SQL server, select the Exception User checkbox in the
User Properties screen.

For more information about automatic synchronization, see the Sentinel online help (click

the Help button ).

Cannot create LUA scripts

Symptoms When trying to create scripts using the LUA scripting language, an error message appears
saying LUA has not been installed.
Cause LUA is the scripting language of Sentinel. It must be installed for you to be able to compile
and execute scripts. Before first use, you must install LUA installation manually.
Resolution 1. Runthe LUA setup file located in the Sentinel installation directory (default
C:\Sentinel\).
2. Follow the instructions.
Upon completion, Sentinel starts its configuration wizard, to make sure that the
essential settings and configuration for Sentinel are correct and available. The
wizard also sets up the proper permissions and security details.
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